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gY P& sessions.

N

its appearance and text.

invitations.

1. This class is a brief introduction to Word 2010. It consists of 2 one and one-half hour
By the endof this class you should be able to create a simple document and manipulate

3. Word is veryuseful in creating documents such as letters, resumes, brochures, flyers or
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Activity 1 -- The student will be asked to download a Word
document from google classroom.

Open the document, and explain it.

e Show that buttons/icons are labeled as you mouse
over. Maximize screen. Review how to use mouse
and cursor. Review use of scrollbar

e Scroll down to Computer Use and Classes. Click on
this link and then on Directions for accessing class
materials or on the Microsoft Word link(s) and
follow instructions. Download one of the, doc
or .docx documents shown here—instructor may
choose.

. Students will complete steps 1 (Open Word)
through 15 (Text Alignment)

Activity 2 — Students will briefly review steps from Week 1
as needed, and then will complete steps 16 (Page Layout and
Design) through 24 (Conclusion and Practice)

The students will be given a print copy of the
instructor’s Word document, and will be shown how edit and
format the document. They will also be given a copy of the
MS Word Quick Guide to keep.




Tasks

Steps and knowledge necessary to complete task.

p B Open Word

Polaris LS 3.6

@‘ Microsoft Word 2010

livenenis Aeaiins Feeieee riee 1 AICK ONCE ON Word icon.

2. Show the “Help” button
and explain

Help is also on the Backstage View page.

3. Show Backstage View
4. Show templates

File tab houses major commands on a page called Backstage View. Show
Open, Save, Save As, Print, Help and Word Options

Save — Show how to save as .doc compatible with Word 97-2003 as
well as .docx for Word 2010

New
&_T.'“_ D — o

P

Print Preview hasn't disappeared. A preview of your document appears on
the nght side of the screen when you click Print in File-Backstage view.
Print settings are on the left.

5 Ribbons — Includes
Tabs and Boxes

Tabs represent related activity areas. In each Tab are Boxes that link related
items. Clicking on a Tab displays the commands needed for that activity.
Briefly show each of the Tabs and their activities. Most features of the
Ribbon will not be used in this class. (Home, Insert, Page Layout,
References, Mailings, Review and View)

Note that Ribbon design is consistent across other Microsoft products
such as Excel and Publisher.

Note the Launcher arrow at the bottom nght of some Boxes. This will open
a Dialog Box which will show other commands or tasks which can be
useful.
aavAm v Al EEaE
- L Dialog Box
Launcher

Context-sensitive Tabs appear on a Ribbon only when they can be used:
Drawing Tools, Table Tools, Picture Tools

Minimizing and Maximizing the Ribbon by using small arrow at top right of
screen, near the Help icon. You may also customize your own Ribbon — not
shown today in this class

6. Quick Access Toolbar

Quick Access Toolbar contains commands you use over and over every
day: Save, Undo, Repeat. You may customize this toolbar by clicking on
File-Word Options-Quick Access Toolbar. You may move it below the




ribbon if you wish by clicking on the Down amow and then clicking Show
Below Ribbon.

Show Undo and explain its value.

O RAR T

Insert

i Ruler Point out View Ruler icon at top of scroll bar on nght side of screen. Or click
on View Tab and then click on Show Ruler in Show box.
B. Quick Review Demo Open Word. A new blank document will appear. Be sure Ribbon is

maximized. Display the Ruler. Add commands to Cuick Access Toolbar.
Close Word without saving your document.

9. Open AuntMadge.docx or
WordSampleCL.docx

Scroll through document

From PPLS website

Scroll up and down one line. Scroll up and down one screen. Drag the scroll
bar to move to specific page. Scroll nght and left. Use Cirl+Home to move
to the top of your document, and Ctri+End to move to the bottom.

10. Basics of Working with
Text
(in AuntMadge.docx or
WordSampleCL.docx)

Dear Aunt Madge,

The family reunion. .

OR

Ann Smith

1115 Rosebud Lo
Plano, TX 75002
072.111.1111

Use either of these documents to

demonstrate all text features, here
and below.

How to insert text. How to delete text.

To insert text: Move mouse to point at which you wish to insert text. Click
mouse and cursor appears at the insertion point.

To delete text: Place cursor next to text to delete. Cursor appears. Use
Backspace key to delete text to the left of the cursorfinsertion point. Use
Delete key to delete text to the right of cursor.

To select text: Place cursor next to text you wish to select. Click and hold
mouse to drag mouse over text to select it. Release it and a highlighted
box appears over the selected text—often the background color is blue.

pru=v-a-s jf
Bk (L= B . B warkats
wr cliants are read ingTRCETEmLcs and respanding to tham
rth will cortinug.

You may see a smaller toolbar *hover over the text with formatfing options.
This can save you time, but you can also use the options on the Ribbon at

the top of the page.
Clicking in margin easily selects text to format:

1 click selects the whole line
2 clicks selects the entire paragraph
3 clicks selects the entire document

11. Copy and Paste
Cut and Paste

Select the text you wish to copy. Click the Copy command on the Home tab
on the Ribbon. Or right-click and select Copy. Place cursor at the point
where text is to appear and click Paste on the Home tab. The copied text

will appear.




i ali
o3 Copy

F Format Pairter

Paste B

To Cut: Select text. Click Cut on the Home tab and then right-click and
select Cut. Place cursor where text is to appear and click Paste. The cut
text will disappear and appear where it is Pasted.

Paste Options: This button appears below your Pasted text. You may
choosa how Word will Paste the text.

Show Copied or Cut text on Clipboard by clicking the Launcher arrow at
the bottom of the Clipboard Box=Clipboard. Cut or Copied items will stay
in the Clipboard buffer and can be used over and over until you copy or cut
another segment.

Remember. Always Select, then Click to act/give the mouse a command.

12. Drag and Drop Text Select the text you wish to copy. Then click and drag text to the location
you want it to appear. The cursor will have a rectangle under the arrow to
show that you are dragging text.

13. Find and Replace To Find: Click on Home tab, then Find (at top nght). Navigation pane

appears. Type text you wish to find in box at top. (Example: flowers) Text if
found will appear highlighted in the document and previewed in navigation
pane. Use amows to show all instances where word appears. Close nav

pane.

To Replace: Click on Home, then Replace. Find and Replace box
appears. Type the text you wish to find in the Find What field. Type the text
you wish to replace it with in the Replace With field. Click Find Next and
then Replace to make the change. Or click Replace All to replace the word
every time it appears.
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1.Each student will gain the basic skills needed to operate and navigate MS Excel.
gY P 2.1dentify, gather and input data into a spreadsheet.

3.Successfully create, copy and paste formulas and functions.

4. to be able to work collaboratively with peers in groups.

5. Successfully print areas of the spreadsheet.

6. Identify Excel as a tool used for manipulating data.

1.1dentify ways of utilizing Excel as a tool

2. Students will be able to identify and create a spreadsheet.

3. Students will successfully record data and be able to create, copy and paste formulas and
2L £ [functions.

4. Students will acquire information using various resources.

5. Review of standard and formatting toolbars and menus within Excel.

6 . Review of worksheets,workbooks,cells,columns,rows,and Excel cursors

7. Introduction of basic use of formulas in Excel.

B
b
i

KEEE 2 =
Introduction:  LCD Projector,
1.  First we will discuss uses of spreadsheets handouts, audio
2. A payroll with three records will be opened and cell equipment.
contents identified. e  Students will be

3. Discussion on the data necessary to complete a payroll.

4. Request that students perform actions such as cell
alignment, formatting cells,shading cells, placing borders
around cells etc. individually.

5. Request that students exhibit knowledge of renaming
worksheets,deleting worksheets, adjusting row heights

provided a
computer
workstation in the
computer lab.

e Students will

and column widths etc. utilize Microsoft
Excel to develop a

Engagement: spreadsheet using
1. Asaclass we will add one record of data. the data they
2. Each student will verbally add their record (fictitious); the obtain.

payroll now contains 10-12 records. e Students will have
3. | will demonstrate formula building, copying, pasting and access to the

printing. Internet.

e Students will be
given a copy of the
rubric to refer to
while working on
this lesson.

Class Practice:

1. Students will complete the payroll (pay).

2. Overtime, bonus will be added to the spreadsheet (use of
absolute value)

3. They are encourage to look on each others screens and
speak out loud.

4. Students will be given opportunity to print (print preview).




Independent Practice: *  Alaptop/projector

1. Students will create a spreadsheet from scratch(grocery set up will be
budget,address list or book inventory a book inventory provided for

2. They will create, copy an paste formulas and functions. presentation.

3. They are encourage to look on each others screens and e Aflash drive will

speak out loud.
4. Students have been asked to complete a detailed budget be used to save and

exercise to exhibit gathered knowledge of MS Excel. copy student work
onto the laptop.
/Accommodations (Differentiated Instruction): *  Ashared drive will
1. Slow typists - they will be able to Open my completed be available to
spreadsheet (as emphasis in this class is not on typing) store completed
2. Quick to create - we we add the overtime calculation and spreadsheets.

bonus (using absolute value)

3. Experienced in a payroll (completed examples of advanced
payrolls will be on shared drive, to be explored during
breaks)

Learning Checkup:

1. 1 will walk around the room as they create and work on
their spreadsheets

2. Challenge students by changing the data (pay rate)- does

the 'ripple down' effect occur?
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Cursor Movement

Selecting Cells

One cell left

[One cell up Ip arrow [One cell IClick once in the cell
One cell d_ﬂ‘i.’i-'ﬂ Fm-‘n arrow or Enter | JAll cells left of SHIFT+1eft arrow
One cell nght |current cell

eft arrow or All cells nght of

SHIFT+Tab

Al)

Top of worksheet (cell

SHIFT+right arrow
current cell -

Click the column label
Click the row label

Entire column

Entire row

data

Any cell

Where the last column
with data intersects
with the last row with

nter the cell address
in the Cell Number

MMove to next
worksheet

Moving and Copying Cells

IClick the whole sheet
button or CTRL+A

Drag mouse over the cells
or hold down the SHIFT
key while using the arrow
keys

Hold down the CTRL key
and use the mouse to
click on non-adjacent
cells

Entire worksheet

ICluster of cells

[Non-adjacent cells

cell and ...

content, highlight the

icon on the Home
Ribbon.

. - . : Using the right mouse Using the

Action Using the Home Ribbon button kevboard
To cut the cell’s Right click on the Use the keystroke
|content that will be Click on the Cut icon on highlighted cell. select Cut JCTRL + X
moved to another the Home Ribbon from the menu that appears.
|cell, highlight the cell )
and

. . q: . Raght click on the Use the keystroke
To copyv the cell’s Click on the Copy highlighted cell. select CTRL + €

Copy from the menu that
appears.

Drag and Drop

to the destination cell
with the mouse.

Highlight the cell into Select Paste from the menu |Use the keystroke
which you want to  |Click on the Paste icon  Jthat appears. CTRL+V
Ipa ste the cut or on the Home Ribbon.
copied cell and ...
Drag the highlighted
border of the selected cell
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had changed your mind, you still can cancel even after you
type in the filename by NOT clicking the OK button at this
point. The file stays on the screen and the new filename,
My tutorial.ppt, appears in the bar above the slide on your
screen. You can exit PowerPoint at any time you want. Just
choose Exit from the File menu.

B ey - Microsoft Power Point Lesson Plan KERPE fach
¥ &= 3BH A(12 &3/F k- & 45 4 48) KB % -
7 T-IV-1 TR T * % 3L
po g [FAIVL i Aspms
FP-IV-1 A2 A AL ~ # a2 R
FOP-IV-2 Bzt
FH-IV-1 B % ik
FH-IV-2 Tt aamie * i
FH-IV-3 Tz >
1. Atthe end of the lesson, the student will be able to launch the program, save a file, and
g¥Yp % exit the program.
2. The student will also be able to correctly identify the default file extension of a
PowerPoint program.
1. The student will demonstrate the ability to:
2. Identify the Program Manager and PowerPoint icon via the Start menu.
3. Be able to launch the PowerPoint program via the program's icon in Program
%21 4 Manager. ) )
4. Open a new file. Save a file. Exit the program. |
5. dentify the naming convention for a PowerPoint file (.ppt).
6. If present or time permits, the student will also demonstrate the ability to: Identify the
PowerPoint shortcut (if present) on the desktop or toolbar.
7. _Launch the PowerPoint program via the PowerPoint shortcut. Repeat the "save and
)E 2 EiEE Y2 - F ivRkH
KEFH KE FE
1. Start Microsoft Windows. MS Office
2. Click Start.
3. Select Programs from the menu.
4. Select MS PowerPoint 2003.
5. Doubleclick to open the program. PowerPoint starts and a
new file opens. Remember, whenever you're creating files,
it's a good idea to save your work on a regular basis. So
even right now we won't be creating any slides, we're going
to save a practice file.
6. Choose Save from the File menu. Because you're saving
the file for the first time, the Save As dialog box appears
7. Type the name of your file--for example, My tutorial--in
the File Name box. Note that you don't need to type a file
extension. The default file extension in PowerPoint is .ppt.
This So if in "My Documents” you had two files, cars.doc
and cars.ppt, you would know that one is a Word file and
one is a PowerPoint file.
8. If you still want to save the file, click the OK button. If you

10
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If you just saved your presentation, PowerPoint closes and
you return to the Program Manager. If there is a shortcut on
the desktop or toolbar, try going into PowerPoint this way:
1. Doubleclick the shortcut icon.

2. 7??What happens here--does it try to open a new file or
does it try to ask you if you want to open the file you just
created?? Not sure--you'd have to check.

3. Based on what happens in step 2, if they open their
previous file, have them type their initials in the text area
and resave the file as part of the independent practice:

MS Office

11
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Xmind —fishbone teaching plan :
TIEE TR AR
(—);@;a%%ﬂmfﬁ‘»ﬁ“aw&ém et
(=) dcrtsid e e 0ot m e Xmind FrEmEa
[ & ] f‘ sb %@'}Tﬁiﬁ e
#cE®:  Sign in your google account. F%%f e
Down load your Xmind from your google drive. 'iw‘ R
& 4 . ( Down their files from the google drive. ) +
[ & o] 3 ITR Y 3 iR 5

*FF
g4

#F*: What else can you do?

g4

: At age 10-12, what can you do?

#F®: Now, you have ten minutes to finish age 10-12.

BEF

Your time is up.

Now export the fishbone as a picture,

Save to the desktop.

And upload to the Google classroom.
Later you are going to share your idea with us.

“ can [go to junior high school jat age12”

12
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content
vocabulary
/ sentences
patterns

A 2.
wBFEF

¥ - TR

Keyboard/mouse | Word vocabulary | Excel vocabulary | Google

Enter Key. Underline Active Cell Google drive
Caps Lock Copy Cell Google classroom
Space Bar Paste Column Google account
Delete New Drag Passward
Print Screen Open File Upload
Pointer

Left-click Save as Sum Download
Double-click Table Average Hand in
Right-click Rank
E S 4

Xmind PPT

Main topic Animation

Insert Guide settings

Tool box Grouping

Floating topic Charts

Summary Picture toolbar

Marker Motion Paths

Label Handout master

Note Slide Show view

Fish bone

Export

FZAEY R

Scratch

Scratch — Coordinates -
Blocks — Drawing —
Projects - Repeat Blocks -
Stage - Cloning -

Scripts - Speech Bubble -
Sprite - Thought Bubble -
Backdrop Volume —
Costumes - Tempo

13
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#3 7 Tryit. You can make it.

iR E K Listen carefully.

% .« Pay attention. Be quiet!

/| ke 34 % Discuss in groups of 4(5)

Good job! Excellent! Awesome!

Raise your hands if you have problems/ questions.
3

like /prefer ...

Please upload your file.

Would you please share your ideas with your classmates?

Would you tell us why you do this way?

Tell your classmates. How did you do it?

It’s time to finish.

Do you get it?

Do you understand?

I’m afraid it’s time to finish now.

We have an extra five minutes.

Just a moment, please.

Have you finished?

Next one, please.

You have ten minutes to do this.

Your time is up.

14




